
HOLLYWOOD ™

SCREENWRITER™

User’s Manual
for Microsoft® Windows®

S
Write Brothers, Inc.
138 North Brand Boulevard, Suite 203
Glendale, California 91203 • (818) 843-6557

24-hour Web Technical Support:  www.screenplay.com
E-Mail Technical Support:  support@screenplay.com
Fax Technical Support:  (818) 843-8364



ii.

The software described in this book is furnished under license and may be
used only in accordance with the terms of such license.

Disclaimer

Write Brothers Incorporated, Ken Schafer and ScriptPerfection Enterprises
make no representation or warranties with respect to the contents hereof and
specifically disclaim any implied warranties of merchantability or fitness for
any particular purpose.  Hollywood Screenwriter™ for Windows is provided
“as is” without warranty of any kind, either expressed or implied.

Write Brothers Incorporated, Ken Schafer and ScriptPerfection Enterprises
shall have no liability or responsibility to you or any other person or entity
with respect to any loss or damage caused by Hollywood Screenwriter™ for
Windows including, but not limited to, any loss of profits, interruption of
service, loss of business or consequential damages resulting from the use of
such programs.

Copyright Notice

Manual written by Kevin Hindley.

Copyright © Write Brothers, Inc. 1999.
Portions © Ken Schafer 1993-96.

All rights reserved.  No part of this publication may be transmitted,
reproduced, stored in any retrieval system or translated into any language or
computer language in any form or by any means, mechanical, electronic,
magnetic, optical, chemical, manual, or otherwise without prior written
consent by Write Brothers, Inc.

Trademarks

Hollywood Screenwriter, Hollywood Screenwriter for Windows, and the
Hollywood Screenwriter Logo are trademarks of Write Brothers Incorporated.
Dramatica is a registered trademark of Write Brothers Incorporated.
SmartCheck, SmartTab, ZapSave, QuickType, and PrintThing are trademarks
of ScriptPerfection Enterprises; WordPerfect is a registered trademark of the
WordPerfect Corporation; Microsoft Word is a registered trademark of
Microsoft Corporation; all others are registered trademarks of their respective
holders.



SCREENWRITER CONTENTS

iii.

Contents

OVERVIEW ..................................................................................................................... 1
The Spec Screenplay............................................................................................... 1

Hollywood’s Screenplay Format ............................................................................. 1

Elements of Screenwriting ...................................................................................... 3

Binding ................................................................................................................. 6

BASIC INFORMATION................................................................................................... 9
Windows® Operating System................................................................................. 9

Selecting Screenwriter Commands .......................................................................... 9

Online Help........................................................................................................... 10

Menus................................................................................................................... 10

Editing Screen........................................................................................................ 14

Opening a Script .................................................................................................... 15

Opening Multiple Scripts........................................................................................ 15

Opening a Previously Saved Version....................................................................... 16

Opening a Timed Backup ....................................................................................... 16

Saving a Script ....................................................................................................... 17

TITLE PAGE .................................................................................................................... 19
Opening a Title Page .............................................................................................. 19

Creating Text Elements........................................................................................... 20

Moving a Text Element........................................................................................... 20

Loading a Title Page............................................................................................... 21

Printing a Title Page............................................................................................... 21



CONTENTS HOLLYWOOD

iv.

SCRIPT FORMATS.......................................................................................................... 23
Loading a Script Format ......................................................................................... 23

Screenplay............................................................................................................. 23

Stage Play.............................................................................................................. 24

Other Formats........................................................................................................ 24

Word Processor format........................................................................................... 24

WRITING THE SCRIPT................................................................................................... 25
Elements ............................................................................................................... 25

Creating Elements.................................................................................................. 25

Tab & Enter ........................................................................................................... 26

Fade In .................................................................................................................. 27

Scene Heading....................................................................................................... 27

Location ................................................................................................................ 27

Time-of-Day .......................................................................................................... 27

Action ................................................................................................................... 28

Character Name..................................................................................................... 28

Character Extension ............................................................................................... 29

Dialogue................................................................................................................ 30

Parenthetical.......................................................................................................... 30

Transition.............................................................................................................. 31

Shot ...................................................................................................................... 31

Title (Centered)...................................................................................................... 31

Act Information (TV and Stage Play Format)............................................................ 31

Scene Information (TV and Stage Play Format) ........................................................ 32

Switch Elements..................................................................................................... 32

Moving between Elements...................................................................................... 33

User Lists .............................................................................................................. 35

Default User Lists .................................................................................................. 35

TEXT EDITING................................................................................................................ 37
Moving the Cursor................................................................................................. 37



SCREENWRITER CONTENTS

v.

Selecting Text ........................................................................................................ 38

Menu Selection ...................................................................................................... 38

Select All ............................................................................................................... 38

Turn off Block........................................................................................................ 38

Mouse Selection..................................................................................................... 38

Left-Click .............................................................................................................. 38

Double-Click ......................................................................................................... 38

Keyboard Selection ................................................................................................ 38

Moving Text .......................................................................................................... 39

Cutting and Pasting with the Mouse........................................................................ 39

Copying and Pasting with the Mouse ...................................................................... 40

Cutting/Copying/Pasting with the Keyboard ......................................................... 40

Dragging and Dropping ......................................................................................... 40

Deleting Text ......................................................................................................... 41

Undo..................................................................................................................... 41

Insert/Typeover Modes.......................................................................................... 42

Bolding Text .......................................................................................................... 43

Underlining Text.................................................................................................... 43

Italicizing Text ....................................................................................................... 43

Striking Out Text ................................................................................................... 43

Applying Multiple Text Formats ............................................................................. 44

SpellCheck ............................................................................................................ 44

Start SpellCheck..................................................................................................... 44

User Dictionaries ................................................................................................... 45

PRINTING THE SCRIPT.................................................................................................. 47
Printer Setup ......................................................................................................... 47

Print the Script....................................................................................................... 48

APPENDIX A—IMPORTING SCRIPTS .......................................................................... 51
Preparing a Script for Importing ............................................................................. 51

Direct Import......................................................................................................... 52



CONTENTS HOLLYWOOD

vi.

Cut and Paste Import ............................................................................................. 53

Importing a WordPerfect 5.0 (for DOS).................................................................... 55

Importing a Windows Word Processor script........................................................... 55

Importing a non-Windows Word Processor script .................................................... 56

Cleaning up Imported Scripts ................................................................................. 56

APPENDIX B—EXPORTING SCRIPTS........................................................................... 59
Export ................................................................................................................... 59

File Type ............................................................................................................... 60

Importing a Screenwriter Export script .................................................................... 60

Cut and Paste Exporting......................................................................................... 61

APPENDIX C—MAIN!MENU!BAR ............................................................................... 63
File Menu .............................................................................................................. 63

Edit Menu ............................................................................................................. 64

Load Format Menu ................................................................................................ 65

Search Menu.......................................................................................................... 65

Goto Menu ............................................................................................................ 65

Spell Menu ............................................................................................................ 66

Window Menu....................................................................................................... 66

Help Menu ............................................................................................................ 66

APPENDIX D—COMMAND KEYS................................................................................ 69
Special Keys .......................................................................................................... 69

Cursor Movement Keys.......................................................................................... 69

Control-Keys ......................................................................................................... 70

Function Keys........................................................................................................ 71

APPENDIX E—UTILITY!PROGRAMS ........................................................................... 73
User Dictionary Editor ........................................................................................... 73

INDEX.............................................................................................................................. 77



SCREENWRITER CONTENTS

vii.





SCREENWRITER OVERVIEW

1.

Overview

The Spec Screenplay

Your ticket to being discovered as a screenwriter and starting your career in
Hollywood is the spec screenplay.  “Spec” is short for speculative, which
means you write it without any up front guarantee of being paid for your
work.  You can look at it as writing a sample script, one that demonstrates your
screenwriting and storytelling talent.  When this script is as professional as you
can make it, you can enter it in screenwriting competitions.  The better
competitions are judged by people working in the film industry, who will read
your script.  You can also send a brief query letter—telling something about
yourself and more importantly, the story in your script—directly to agents,
producers, directors, actors, and other industry players, asking if they’d like to
read your script.

If they do read it, here are the outcomes you’re looking for:

• A player buys or options your screenplay.  Your career has begun.

• They like the writing but don’t want to make a movie based on your script.
They may hire you to write another screenplay, based on an idea of theirs
or yours.  Again, your career has begun.

• They like the writing but not the story.  They ask to see something else
you’ve written.  This is great, too.  Keep writing spec screenplays, keep
improving your writing, and keep submitting.

Hollywood’s Screenplay Format

An important part of making your script read like a professional script is the
format.  The special spacing, capitalization, margins, and page breaks are
designed with one thing in mind—production.  It’s all about money.  If you use
the correct format, the screenplay page will take up about one minute of screen



OVERVIEW HOLLYWOOD

2.

time when filmed.  So, the page count roughly equals the length of the movie
in minutes.  This is for the benefit of the Production Manager, who must break
down the script and sort the scenes by location, day or night, and other criteria
in order to create a shooting schedule.  The idea is to shoot the film in the
shortest time possible, thus saving money and reducing the budget.

When you submit your spec script, the first (and perhaps only) person who
will read it is the Story Analyst or Reader.  Their job is to read scripts and pick
out the great ones.  These are recommended to their boss, who is too busy to
read everything that is submitted.  Readers have come to expect all scripts to
look the same—in the accepted professional screenplay format.  Their
reasoning is that if the writer can’t get the format right, how can they be
expected to do justice to the structure, dialogue, plot, characters, or any other
part of screenplay storytelling?  If your script doesn’t look like a professional
script, they won’t treat it like one.  They may toss it in the trash without even
reading it.

How To Format Spec Scripts Perfectly

You’ve got this part of the process mastered already—this is exactly what
Hollywood Screenwriter does!  In fact, it goes even further—it won’t let you
format the spec script incorrectly.  You can concentrate your time, energy, and
creativity on the story and the writing.

Scene Numbers

Q. Why doesn’t Hollywood Screenwriter number the scenes like the scripts of
produced movies that I’ve read?

A. Because those were shooting scripts, used in the actual shooting of the film.
Spec scripts don’t need scene numbers because your script will be
rewritten many times before it is shot.  They can be added later, usually by
the studio’s script typing department.  Putting scene numbers in a spec
script achieves one thing—it clutters up the script, making it a more
difficult read.  And you don’t want to do anything to make your script
harder to read for the creative person with limited time.  That applies to
Scene Continued’s, too.  On shooting scripts, the bottom of almost every
page and the top of the next one has the word Continued.  This indicates
that the scene is continued on the next page or continued from the
previous one.  In a spec script, this just takes up extra space and makes the
script longer.
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Margins

Q. Why can’t I cheat the margins and/or spacing to make my script appear
longer or shorter?

A. The key words here are cheat and appear.  When the script is retyped in the
correct format—and if someone purchases it, it will be—the correct page
length will be revealed.  And you’ll have to delete from or add to the
scenes.  Cheating tries to fool the reader, and comes from the
unwillingness or inability of the writer to master screenplay form.  You’re
better off doing the adding or deleting beforehand, and developing the
discipline of a tight, lean writer now.  By the way, the ideal length for a
spec screenplay is between 90 and 120 pages.

Elements of Screenwriting

A screenplay is formatted using different elements—with different margins,
spacing, capitalization, etc.—for each part of the script.  A description of each
element, with example text, is shown below.  (Note that the examples are
shown in boldface for emphasis only.  Do not use boldface text in your scripts.)

Act Information

In a TV script, ends one act and starts another.  Usually with a page break
inbetween.

END OF ACT ONE

===ACT/SCENE
BREAK================================

ACT TWO

SCENE A

Action

Shows what the characters are doing in the scene, and briefly describes where
they’re doing it.



OVERVIEW HOLLYWOOD

4.

EXT. STREET - DAY
Uncle Billy is walking along the street, humming
happily to himself.  He sees some men decorating
the Court House with banners and bunting --
there is a huge sign reading:  Welcome Home
Harry Bailey.

Character Name

Indicates who’s speaking.  It is immediately followed by a Dialogue element
(or a Parenthetical element).

UNCLE BILLY
(calls out)

Be sure you spell the name right.

Dialogue

Contains what the character says.  It immediately follows a Character Name
element (or a Parenthetical element).  Note that you cannot create a Dialogue
element (or convert another element to Dialogue) without creating a Character
Name element first.

UNCLE BILLY
(calls out)

Be sure you spell the name right.

Parenthetical

Indicates how the character speaks, when that’s not clear from the dialogue
itself.  It immediately follows a Character Name element, and is immediately
followed by a Dialogue element.  It can also be placed in the middle of a
Dialogue element.  Note that you cannot create a Parenthetical element (or
convert another element to Parenthetical) without creating a Character Name
element first.

UNCLE BILLY
(calls out)

Be sure you spell the name right.

Scene Heading

At the beginning of a scene, tells when and where the scene takes place.
Indicates that the story has moved to a new location or time.  Includes
INT./EXT., Location, and Time Of Day.
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EXT. STREET - DAY

Uncle Billy is walking along the street, humming
happily to himself.  He sees some men decorating
the Court House with banners and bunting --
there is a huge sign reading:  Welcome Home
Harry Bailey.

Scene Information

In a TV script, ends one scene and starts another.  Usually with a page break.

END OF ACT ONE

===ACT/SCENE
BREAK================================

ACT TWO

SCENE A

Shot

Indicates a camera angle, usually putting emphasis on one thing.

The door closes on Uncle Billy’s fingers.

UNCLE BILLY’S EYES

He’s trying not to cry, but the tears flow
anyway.

Title (Centered)

Used to center text horizontally on the page.  Instead of using FADE IN:, some
writers prefer to print the script title and their name at the very beginning of
the script.
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IT’S A WONDERFUL LIFE

by

Robert Riskin

EXT. STREET - NIGHT

George, in the uniform of an air raid warden, is
patrolling his beat.

Transition

Emphasizes a change in time or location, between two scenes.  Usually ends
with TO:  Use sparingly.

Uncle Billy remains sobbing at the table, his
head in his arms.

CUT TO:

INT. GEORGE'S LIVING ROOM - NIGHT

Extension

Part of the Character Name element.  Used when the character speaking is
offscreen or in voice-over.

George is walking along the sidewalk, reading a
newspaper.

JOSEPH (V.O.)
This morning, day before
Christmas, about ten a.m. Bedford
Falls time...

George comes to where Ernie, the taxi driver, is
standing on the sidewalk.

Binding

Your script should look like the scripts submitted by professional writers and
their agents.  Just like screenplay format, there is a standard way to bind
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scripts.  Do not use spiral binding, fancy report covers, Velobind, or any other
method that’s acceptable for documents that are not screenplays.  Use only  3-
hole punched white paper with plain cardstock covers, bound with 2 brass
brads.  Don’t write the title or anything else on the covers or side edges of the
script.

Paper

Use regular 8-1/2 by 11 white 20-pound paper, the kind sold for photocopying
machines.  Make sure it’s 3-hole punched, unless you have a machine for doing
it yourself and endless patience.

Covers

Use 110-pound cardstock, in a plain solid color.  These are usually not 3-hole
punched, so you’ll need that 3-hole punch machine.   Place 1 blank cover on
the front and 1 blank cover on the back before binding everything together
with 2 brass brads.  Make sure your pages are in the correct order and that
none are missing.  Resist the temptation to put fancy drawings, photos, or
designs on the covers—these tell the reader that you are an amateur.  Instead,
put all that creativity into your writing.

Brads

Use solid brass Acco #5 (1-1/4”) or #6 (1-1/2”) brads.  They are sold in boxes
of 100.  Accept no substitutes.  The cheap, brass-plated steel ones do not stay
flat—they spring back, protruding enough to scratch people’s desks, laps, and
car seats.  Put only 2 brads on your script, leaving the middle hole empty.  On
the back of the script, flatten the prongs of each brad against the back cover by
bending them at 90 degrees.  Brass washers are optional, but they do keep the
brads from coming loose.

Mailing

It’s polite, and good business practice, to send out a query letter before sending
your script.  If you write a good enough query letter, the reader will be
intrigued and ask to see the script.  If they receive your script without having
asked to see it, they will probably send it back unopened.  This protects them
from any accusations that they read the script and stole the ideas in it.
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Alternatively, they will do what most people do with unsolicited junk
mail—throw it in the trash unopened.
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Basic Information

Windows® Operating System

Using Hollywood Screenwriter and this manual assumes a basic familiarity
with Microsoft Windows 3.11, 95, 98, or  NT.  Teaching or supporting this
operating system is beyond the scope of this manual.  For help with Windows,
go to your Microsoft Windows manual, Windows online Help, or contact
Microsoft Corporation.

Selecting Hollywood Screenwriter Commands

There is usually more than one way of performing a function in Hollywood
Screenwriter.  For ease of use, this manual shows you how to select commands
using the Mouse and the Main Menu Bar.  As you become more familiar with
Hollywood Screenwriter, you many want to use Keyboard Shortcuts and
SpeedBar Icons.

To see what command a SpeedBar Icon represents, use the mouse to move the
cursor over the icon without clicking on it.

A box of explanatory Hint text displays directly beneath the icon, and any
Quick Key shortcut displays on the left of the Bottom Status Bar.

For a list of Main Menu Bar commands, see the Appendix chapter entitled
Main Menu Bar.

For a list of Keyboard Shortcuts, see the Appendix chapter entitled Command
Keys.
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Online Help

When writing your script, help with Hollywood Screenwriter is always
available online, under the Help Menu:

Contents brings up a Table of Contents for the help file.

Search for Help on... displays the help file’s searchable Index.

Quick Help displays a sample script page.  Get help information about any
Element or item by clicking on it.

If you make a selection under the Main Menu Bar, context-sensitive help is
available.  When the menu screen displays, click on the Help button or the ?
button.

Helpful information, explaining what each selection on that menu does,
displays.

Menus

Main Menu Bar—Hollywood Screenwriter’s Pull-Down menus are accessed
from the Main Menu Bar at the top of the screen.  Individual Menus may be
selected with the mouse, or by pressing Å plus the underlined letter of the
Menu (such as Å+P for S     p     ell ).

There are three types of menu:

PULL DOWN MENU

Pull-down menus pull down from the Main Menu Bar.  Each option has an
underlined QuickSelect letter as part of its name, as in the      S     pell Menu in the
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example.  With the Menu displayed, select an option using any of these
methods:

• Scrolling through the options with the arrow keys and pressing Â

• Use the mouse to click on an option

• Pressing the appropriate QuickSelect Letter (e.g., “w” to select        W       ord)

NOTE: If there is a Windows Quick-key equivalent for a menu option, it
displays to the right of the Menu Item (as in Ctrl+L for Word in the
example above.)

LIST MENU

List Menus are scrollable menus with text items selectable for input into your
script without typing, such as the Character List in the example.

To select an item, you would:

• Type enough letters to match the item you want (typing “H” highlights
“Helmer”, while typing “Helmer a” highlights “Helmer and Nora”).
Then press Â

• Click on the item you want, using the mouse

• Scroll through the items with the arrow keys, and press Â to
select the highlighted item

More items can be viewed by clicking or dragging in the scroll bar on the right
of the menu.
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DIALOG BOX

Dialog boxes have different types of input options, including Push Buttons,
CheckBoxes, Radio Buttons, and Text & Numerical Input Fields.  Most options have
an Underlined QuickSelect letter.  Select the option you want using any of
these methods:

• Moving around in the menu by pressing † or ß+†

• Clicking on it with the mouse

• Pressing the QuickSelect letter on the keyboard (if you’re already in a
Text or Numerical Input Field such as     S    elected Pages and want to
move to another, such as Current      P     age, press Å+R to distinguish
from text input).

PushButtons

There are four PushButtons (displayed as rectangular boxes) on the Print
dialog box in the example above:  Fax, OK, Cancel, and Help.  Select a Push
Button using any of these methods:

• Moving to it with the arrow or † keys and pressing Â;

• Clicking on it with the mouse

• Pressing its underlined QuickSelect letter (if any) from the keyboard.

Selecting OK always exits a dialog box, accepting all of the current settings.
Selecting Cancel always cancels a dialog box without changing anything.
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CheckBoxes

An example of a CheckBox (displayed as a small box, either blank or with a
Checkmark in it) is shown on the example Print dialog box on the previous
page, titled Print the      T     itle Page.  A CheckBox can be checked or unchecked
using one of these methods:

• Moving to it with the arrow or † keys and pressing the Space Bar

• Clicking on it with the mouse

• Pressing the Underlined QuickSelect Letter from the keyboard (in this
example, “r” for      R     un).

Radio Buttons

There are many Radio Buttons (displayed as a small circle, either blank or with
a dot in it) on the example Print dialog box.  The first two are:  Current      P     age
and      E     ntire Script.  Radio Buttons are similar to CheckBoxes, except that only
one Radio button in any given group may be checked at any one time.

Text or Numerical Input Fields

Text or Numerical Input Fields (such as      S     elected Pages or N     u     mber of Copies
on the example Print dialog box) allow you to enter text or numbers as
appropriate.  Depending on the particular field, spaces may be allowed and
text may be automatically capitalized for you.
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Editing Screen

The default editing screen has several bars on screen.  The top most bar is the
Main Menu Bar     which gives you access to all of the Pull-Down Menus.

Beneath that is the      Top         SpeedBar     with Speed Buttons for frequently used
tasks.  To see what any Speed Button does, move the mouse cursor arrow over
it.  A hint explaining its function appears immediately underneath the button.
Another explanation, often giving the Quick Key command, may also appear
on the status bar at the bottom of the screen.

At the right of the screen is the      Right         SpeedBar    .  A Right SpeedBar icon button
inserts an element at the cursor position.

Across the bottom of the screen is the      Bottom Status Bar    .  On its left side it
displays a “hint” about the item the cursor is currently over.

To the right of that is the     Insert/        Typeover Button     , which toggles between
Insert and Typeover modes.  In Insert mode, whatever you type is inserted
before the cursor.  In Typeover mode, whatever you type writes over the text
after the cursor position, replacing it.  Insert mode is in common use in most
word processing and screenwriting programs.

Next to that is      Line     &      Position     , information, telling you where the cursor is
located onscreen.
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Opening a Script

Under the File Menu, select Open .  Select from the list of available files,
changing the subdirectory, drive, or file type if necessary.

Click on OK to open the file.

To open a file you’ve recently saved, select one of the numbered files at the
bottom of the File Menu.

Opening Multiple Scripts

Hollywood Screenwriter allows you to have up to 9 files open at the same time.

To have more than one script open, Open them one at a time under the File
Menu.  Initially, they each open in full screen.  To see several of them on screen
at once, you can resize them and open multiple windows:

Displaying Multiple Windows    

Under the Window Menu, select either Cascade or Tile:

Tile—shows all open scripts, each at full page width, stacked horizontally
above each other.  Makes for easy cutting and pasting.

Cascade—shows all open scripts with reduced windows, overlapping each
other.  The most recently opened script is at the front, becoming the currently
displayed file.

Switching between Windows    

If all the windows are visible on screen, switch between them by clicking
anywhere on a script’s window.

If the windows are Maximized  (i.e. at full screen size,) then:

Select the script to display by clicking on its name at the bottom of the
Window Menu.

Or, press Ç+§, or Ç+† to cycle between the open windows.
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Opening a Previously Saved Version

When you tell Hollywood Screenwriter to save a script, it makes a backup copy
of any previously saved version with the same name.  The suffix .HWS is
changed to .BK for the previous version.

If you need to go back to that previous version, load the .BK file:

1. Under the File Menu, select Open .

2. Change the File Type from Hollywood Screenwriter Scripts to Prev.
Saved Script.

3. Select from the list of available .BK files, changing the subdirectory,
drive, or file type if necessary.

4. Click on OK to open the file.

Now both versions of the file, the old .BK and the latest .HWS, are open.
Switch between them under the Window Menu.

To keep a copy of the .BK version, save it under a different name (for example,
if the filename is OSCAR.BK, save it as OSCAR1.HWS).  Leaving its name with
the suffix .BK allows it to be overwritten next time you save—which is not
what you want.

Opening a Timed Backup

Hollywood Screenwriter makes an emergency backup of the currently
displayed script at timed intervals.  This is in addition to the automatic .BK
backup file created when you save a script, and is saved separately.  To open a
Timed Backup file:

1. Under the File Menu, select Open .

2. Change the File Type from Hollywood Screenwriter Scripts to
Timed Backup.

3. Select from the list of available .TMB files.

4. Click on OK to open the file.

To keep a copy of the .TMB version, save it under a different name (for
example, if the filename is SAVE2.TMB, save it as <FILENAME>.HWS.)
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Saving a Script

To save an open file, display it onscreen.  (If you have multiple scripts open,
select the file to display by clicking on its name at the bottom of the Window
Menu .  A checkmark appears next to its name, and it becomes the currently
displayed file.)

Under the File Menu, select a save option:

Close—exits the script, without exiting Hollywood Screenwriter.  If you’ve
made changes without saving, it prompts you to save the file.

Save—saves your script under its current name, or asks for a new name if
you haven’t already named the file.

Save As...—goes to the Save As... Menu.  You can change the script name, its
subdirectory, or file format.

Exit—closes all scripts and exits Hollywood Screenwriter.  Prompts you to
save any open scripts with unsaved changes.
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Title Page

A Title Page is placed before page 1 of the script.  In a spec script, all it needs to
contain is the script’s title, the author’s name, and an address and contact
phone number.

Hollywood Screenwriter’s Title Page Publisher allows you to create a title
page with a WYSIWYG (“What-You-See-Is-What-You-Get”) page layout.
Gridlines are displayed to help you position your text boxes, and do not print.
The title page is automatically attached to the script and is saved with it, yet it
stays out of your way while writing.

Opening a Title Page

Under the File Menu, select Title Page Publisher and you’ll see a screen like
the one in the example above.  You can enlarge or reduce the size of the title
page displayed onscreen with the Full Page and Zoomed buttons at top right.



TITLE PAGE HOLLYWOOD

20.

Creating Text Elements

Double click anywhere on the title page to create a text element.  The Edit Text
dialog box displays.

Type your text.   To change the text’s style, highlight the text then click on the
appropriate style button.

The Left three buttons allow you to select Bold       Underline     and Italics
respectively.

The next button lets you select the text’s Font.

The next three buttons allow you to select Left Justified, Centered, or Right
Justified text.

NOTE: All the text in any given text element will have the same style (i.e.
bold, underline, etc.), font, and justification.  If you want the script’s Title
to appear differently from the Author’s name (for example, underlined),
use different text elements for each and align them as desired.

Click OK and the Edit Text window disappears, placing your text in a text
element on the Title Page.

Moving a Text Element

Select the text element by single-clicking on it with the mouse.  You can now
move it using any of these methods:

• Dragging it to where you want it to go.

• Pressing the arrow keys on the keyboard.
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• Clicking on the Horizontal and Vertical text alignment buttons at
the right of the title page.

X and Y axis displays at the upper right of the screen show how far from the
left (X) and top (Y) margins of the page your text element starts.  These
measurement change as you move the text element, and are shown in your
selection of Inches or Centimeters.

A Grid helps you position text elements on the page.  Check Show Grid to
display it.

Saving a Title Page

As the Title Page is saved as part of the script itself, there’s no need to save it
separately.  To save it as a template for use with other scripts, simply click on
the Save button and give it a name.  A file extension of .TPG  is automatically
added to a Title Page Template file you save.

Loading a Title Page

You can load a title page that is part of another Hollywood Screenwriter script,
or was saved as a Title Page Template file.  Click on the Load Button.

On the Open Title Page dialog box, load an existing Title Page Template file
by selecting a file ending in .TPG and clicking Open.

To load a title page that is part of another Screenwriter script, click the Load
Button then change the List files of type: from Title Page to Hollywood
Screenwriter Scripts.  Select a file ending in .HWS (or .SCW) and click Open.

Printing a Title Page

From within Title Page Publisher, print the Title Page by clicking the Print The
Title Page Button.

To print from outside Title Page Publisher, under the File Menu, select Print.
On the Print dialog box, select which pages to print, and check Print Title
Page.
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Script Formats

Hollywood Screenwriter has pre-set format files for:

• Screenplay

• TV Templates

• Stage Play

As a default, Hollywood Screenwriter loads Screenplay format each time you
open a blank script file.  However, you can easily switch to one of the other
formats:

Loading a Script Format

Under the Load Format Menu, click on the format you want.

If you already have a script open and displayed onscreen, loading a different
format applies the new settings to your existing script.

Screenplay—the standard feature film format, also used for most MOW’s (TV
Movies) including Miniseries, Episodic Dramas including Soaps, and
Animation.

NOTE:  There is no one standard format for Television shows.  It’s
recommended that you get at least two scripts from the show you’re
writing for and match the format before submitting your spec.  Reading a
show’s scripts also gives you a better feel for the characters and the kinds
of stories that get made.  Try to get scripts from the current season.
(Templates for certain TV shows are supplied with Hollywood
Screenwriter.  See Television Templates, below.)
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Stage Play—based on the professional published formats used by Samuel
French.  Narrow Action margins with Parenthesis, wide Dialogue margins, and
Act & Scene Information.

TV Templates—based on the actual production scripts used by the TV shows,
they have the correct margins, formatting, character lists, act and scene breaks,
and even sample text for the top Sitcoms, Soaps,  and Episodic Dramas.

Other Formats

Word Processor—can be used from within any other format.  Puts you in a
mode where Tab and Enter function as in normal word processing programs.
Effectively switches off Hollywood Screenwriter’s script formatting features,
though you can still insert script Elements.  To switch to WP mode:

Under the Edit Menu, select Normal WP mode.

A checkmark appears next to Normal WP mode on the menu, and the left of
the Bottom Status Bar displays a message in Red to remind you that you’re in
WP mode.

To exit WP mode, repeat this command sequence or press ç+W.
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Writing the Script

Elements

Each part of a script is formatted uniquely, with different margins,
capitalization, and spacing.  Hollywood Screenwriter uses these elements:

• Act Information

• Action

• Character Name

• Dialogue

• Parenthetical

• Scene Heading

• Scene Information

• Shot

• Title (Centered)

• Transition

Creating Elements

You can create Elements in a number of ways:

• Click on an element in the pull-down Current Element window
(changes the current element)
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• Click on the element’s icon on the Right SpeedBar, if displayed
(inserts the element at the cursor position)

• Press a Ç-key shortcut for that element
(See the Appendix chapter entitled Command Keys for details)

• Type an element’s text and it is automatically formatted in certain
elements:

—type int. or ext. in a new Scene Heading or blank Action element

—type fade in: or press Â at the start of a new script,

—type in Transition text, ending it with to:

Tab & Enter

You can easily go from element to element in Hollywood Screenwriter by
pressing just two keys—† and Â.  Your fingers need never leave the
keyboard (unlike using a Control-key shortcut, or using the mouse,) enabling
you to stay in the flow of writing your script.

Based on which Element the cursor’s in, Hollywood Screenwriter makes an
informed guess as to what you’d like to do next.  It places you in the logical
next Element, and pops up a menu of possible choices.  For example, if the
cursor’s in a blank Character Name element and you press Â, a list of all
the Character Names in your script pops up for your selection.

The following element instructions use the Tab & Enter method.
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Fade In

On the first line of a new script, press Â.
A Pop-up list displays, with Initial Scene Heading Text options.

Type "f" for      F     ade In, and FADE IN: is entered for you, correctly formatted.
The cursor drops down to a new line and makes it a Scene Heading, which is
the element that usually follows Fade In:

Scene Heading

A Pop-up list displays, with Initial Scene Heading Text options.

Type in the underlined QuickLetter of your selection, and it’s entered for
you.  For example, type “e” for      E     XT to enter “EXT.” and the correct spacing
following it.  (Type “v” for Ne     v     ermind to Cancel, or press Ÿ)

Next, enter a Location.

Location

To enter a Location, type it.  For example, "detective's office".  It will be
automatically formatted as All Caps.

Next, enter a Time-of-Day.

Time-of-Day

Enter a Time-of-Day by pressing Â after typing your Location.

A Pop-up list displays, with Time-of-Day options.
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Type in the underlined QuickLetter of your selection, and it’s entered for
you.  For example, type “d” for       D      AY to enter “DAY” and the correct spacing
and dashes before it.

Your Time-of-Day is entered, and the cursor moves to a new Action element.

Action

Type your characters’ descriptions and activities in the Action element.

Press Â to go to a new paragraph of Action.

Press Â twice to go to a new Scene Heading element.

Press † to go to a Character Name element.

Character Name

To create a new Character Name, type it in.

To enter a Character Name that’s already been used in this script:

1. Press Â.  A Pop-up list of available Character Names displays.

2. Type the first letter of the character’s name you want.  The name
becomes highlighted.

3. Press Â.  The Character Name is entered, and a Dialogue element is
created.

To enter an existing Character Name by first letter:

1. Type the first letter of the character’s name, e.g. "h".  A Pop-up list of
Character Names starting with that letter displays.
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2. Type enough letters until the name you want is highlighted and press
Â.  The Character Name is entered, and a Dialogue element is
created.

3. (To enter a Character Extension, press "("(left parenthesis) instead of
Â.  The Character Name is entered, and a Character Extension Pop-
up List displays.)

Character Extension

An Extension is a modification to the Character Name, appearing directly
after it in parentheses (or on the next line, if you prefer).  It is commonly
used to indicate that the Character speaking cannot be seen speaking
onscreen.  The two most common Extensions are:

• V.O. —meaning Voice Over, which tells the reader that the character is
commenting on the onscreen action but is not part of it, or is narrating
over the scene.

• O.S. —meaning Off Screen, which tells the reader that the character is
not visible on screen but is nearby somewhere in the scene.

To enter a Character Extension:

1. Press ( (left parenthesis) while the cursor is anywhere in a Character
Name and a Character Extension Pop-up List displays.

2. Type in the underlined QuickLetter of your selection, and it’s entered for
you.  For example, type “v” for (     V     .O.) and (V.O.) is entered.

Add as Text—enters whatever you type as a Character Extension,
without adding it to the User List.

The cursor moves to a new Dialogue element.

(If you pressed Â and the cursor’s already gone to a blank Dialogue
element, press ø to return the cursor to the Character Name element.
Then press ( (left parenthesis).)
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Delete a Character Extension

With the cursor at the end of a Character Name element, press ƒ to delete
the Character Extension.

Or, with the cursor anywhere in a Character Name element, press ( (left
parenthesis).  A Character Extension Pop-up List displays.  Type “e” for No
E     xtension.

The cursor moves to the Dialogue element following the Character Name.

Dialogue

A Dialogue element can only be created immediately following a Character
Name (or its Parenthetical) element.

1. With the cursor in a Character Name or Parenthetical element, press
Â.  The cursor moves to a new Dialogue element.

2. Type your character’s dialogue.

3. Press Â.

4. The cursor moves to a new Action element.

Second Dialogue Paragraph

To split up a long paragraph of Dialogue into smaller chunks, you can enter
it as two or more shorter paragraphs of Dialogue.

To enter a second paragraph of Dialogue, press Å+Â twice to put in
two hard returns.

Parenthetical

With the cursor anywhere in a Dialogue element, press ( (left parenthesis).
A Parenthetical element is created at the cursor location.

If the cursor is at the beginning of a Dialogue element, the Parenthetical is
placed between the Character Name and the Dialogue.

If the cursor is in the middle of a Dialogue element, the Dialogue is broken
by the Parenthetical.
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Type the Parenthetical text, then press Â.
The cursor moves to the Dialogue element following the Parenthetical.

Transition

With the cursor at the beginning of any blank element, type any Transition
text ending in to:  Hollywood Screenwriter automatically formats and spaces
it correctly at the right margin.

A new Scene Heading element is created, and a Pop-up List of Initial Scene
Heading Text displays.

Or, press Â in a blank Action element and type “t” for Make this a
T     ransition.

Shot

Press Â in a blank Action element and type “h” for Make this a S     h     ot.
Then type any text for your Shot.

Press Â and a new Action element is created.

Title (Centered)

You can create a centered title that doesn’t contain Act or Scene information.
As an example, some writers prefer to start the first page of their script with
the script’s title underlined, instead of Fade In:

First create a blank Action element.  Then click on the Current Element
window on the Top SpeedBar, and select Title (Centered) from the drop
down Menu that displays.

Act Information (TV and Stage Play Format)

Prologue Text
Type any valid Prologue Text at the beginning of a blank element (the only
Prologue Text that Hollywood Screenwriter recognizes is TEASER,
PROLOGUE, or COLD OPENING.)  Hollywood Screenwriter automatically
centers and capitalizes it.
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New Act
To start a New Act:

Type NEWACT (this is all one word, without a space) at the beginning of
any blank element.  Hollywood Screenwriter centers it and changes it to
ACT #, where # is the new Act Number.  (A forced page break will not be
entered.)

Same Act
To continue the Same Act, type SAMEACT (this is all one word, without a
space) at the beginning of any blank element.  Hollywood Screenwriter
centers it and changes it to ACT #, where # is the same Act Number.

End of Act
To end an Act, type END OF (this is two words, with a space) in a blank
Action element.  The appropriate End of Act info is entered, followed by a
forced page break.

Scene Information (TV and Stage Play Format)

New Scene
To start a New Scene:

Type NEWSCENE (this is all one word, without a space) at the beginning of
any blank element.  Hollywood Screenwriter centers it and changes it to
SCENE #, where # is the new Scene Number.  (A forced page break will not
be entered.)

Or, press Â while in an Act Info Line and Hollywood Screenwriter puts
in the appropriate New Scene Info for you.

Switch Elements

To convert one element to another (for example, Action to Shot):

1. Put the cursor anywhere in the Element to be changed.  (Or, select a
portion of the element to change.)

2. Click on the Current Element Window on the Top SpeedBar to display
the Pull-Down List of elements.

3. Select the element type to switch to by clicking on it.



SCREENWRITER WRITING THE SCRIPT

33.

Moving between Elements

Pressing Tab or Enter in one element either moves you to a new default
element or displays a List Menu of available options:

If you Type— Hollywood Screenwriter will—

FADE IN:
or any Transition

display Scene Heading Initial Text menu
(INT., EXT., etc.)

If you Press Â
while in—

Hollywood Screenwriter  will—

blank Action,
Transition,
blank Scene Heading,
Scene Info,
or End of Act

display Scene Heading Initial Text menu
(INT., EXT., etc.)

Scene Heading
without Location

display a List Menu of all unique Locations
already in the script

Scene Heading
with Location

display a List Menu of Time-of-Day (DAY,
NIGHT, etc.)

End of Action add another Action Element

Character Name add a Dialogue Element
(If the next element is Dialogue or
Parenthetical, it moves to the beginning of
that element)

End of Dialogue add an Action Element

Middle of Dialogue break the Dialogue and insert an Action
Element.

Parenthetical add a Dialogue Element
(if the next element is Dialogue, it moves to
the beginning of that element).

Pop-up menus can be displayed manually by pressing the appropriate Control
key combination:
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If you
Press—

While in— QuickType will—

Ç+O any element add a Shot element

Ç+
Â

any element add an Action element

Í+
Ç+C

Action or Dialogue element display a List Menu of
existing Character Names

† any element add a Character Name
element

( Character Name element display a List Menu of
Character Extensions (V.O.,
O.S., etc.)

( Dialogue element add a Parenthetical element

Ç+T any element add a Transition element

Character Name in Dialog/Action

To put an existing Character Name into Dialogue or Action without typing it
in again, press Í+Ç+C.

A Pull-Down menu displays, with all the existing Character Names.  Select
one and it is entered as text at the cursor position.

Forced Page Break

To end a page short and start a new page, enter a Forced Page Break at the
cursor position.

Under the Edit Menu, select Add Forced Page Break.

Or, press ß+Â.

Remove a Forced Page Break
Remove a Forced Page Break using one of these methods:
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• Put the cursor either before or after the forced page break.  Under the
Edit Menu, select Remove Forced Page Break.

• Or, put the cursor at the beginning of the element immediately following
the Forced Page Break.  Press the ı key.

• Or, put the cursor at the end of the element immediately before the
Forced Page Break.  Press the ƒ key.

Hard Return

To end a line short and start a new line, enter a Hard Return at the cursor
position.

Under the Edit Menu, select Add Hard Return.

Or, press Å+Â.

User Lists

While you write, Hollywood Screenwriter can recognize certain text you’ve
typed as matching an item in one of its User Lists, and format it as the
appropriate element automatically.

For example, typing “ext.” on a blank line tells Hollywood Screenwriter that
you’re starting a new Scene Heading.  It automatically formats your entry as
“EXT.”

Typing a Location in your script and pressing Â pops up the Time-of-
Day User List.  Typing the first letter (or underlined QuickLetter) of a Time-of-
Day enters it in your script and moves the cursor to a new Action element.

These pop-up menus, or User Lists, contain text items that can be entered by
typing the first letter or two instead of typing the whole text, saving you time
and effort.

NOTE:  Transitions are an exception.  Any text that ends with TO: is
recognized as a transition, whether or not the text is in the Transition User
List.
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Default User Lists

When you install Hollywood Screenwriter, all User Lists except for Character
Names and Locations have default items which are used for all new and
imported scripts:

User List Default Items

Character Names Empty

Extensions “O.S.”

“V.O.”

Scene Heading Text “INT.”

“EXT.”

Time-of-Day “DAY”

“NIGHT”

Transitions “CUT TO:”

“DISSOLVE TO:”

 “FADE OUT:”

Act/Scene Info “NEWACT”

“SAMEACT”

“NEWSCENE”

Prologue Text “TEASER”

“PROLOGUE”

“COLD OPENING”

Tag Text “TAG”

End of Act Text “END OF”
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Text Editing

There is usually more than one way of performing any text selecting or editing
command in Hollywood Screenwriter.  For ease of use, the method using the
Mouse and the Main Menu Bar is emphasized.  As you become more familiar
with Hollywood Screenwriter, you many want to use Keyboard Shortcuts and
SpeedBar Icons.

To see what command a SpeedBar Icon represents, use the mouse to move the
cursor over the icon without clicking on it.  A box of explanatory Hint text
displays directly beneath the icon, and any Quick Key shortcut displays on the
left of the Bottom Status Bar.

For a list of Main Menu Bar commands, see the Appendix chapter entitled
Main Menu Bar.

For a list of Keyboard Shortcuts, see the Appendix chapter entitled Command
Keys.

Moving the Cursor

Use the following keys to move the cursor around the script quickly:

Å+˜ ................................... Previous Element

Å+¿ ................................... Next Element

Ç+Å+Ó .......................... Goto Top of Script

Ç+Å+Ì .......................... Goto End of Script

Ç+G .................................. Goto Page Menu

˘ .......................................... Next character

¯ .......................................... Previous character
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Ç+˘ .................................. Next Word

Ç+¯ .................................. Previous Word

Ó ......................................... Beginning of current line

Ì ......................................... End of current line

˜ .......................................... Previous Line

¿ .......................................... Next Line

“ ......................................... Previous Screen

” ......................................... Next Screen

Selecting Text

Hollywood Screenwriter uses the standard Windows methods of text selection.

Menu Selection—place the cursor in the text to be selected.  Under the
Edit Menu, choose from:

Select All—selects the entire script.

Turn off Block—de-selects the currently selected block of text.

Mouse Selection—Hollywood Screenwriter has these options for selecting
text with the mouse:

Drag Select—using the mouse, Left-Click directly in front of the text to
be selected.  While holding the Left Button down, drag the mouse cursor
across the text.  Release the button when all the desired text is
highlighted.  (To continue selecting text that’s offscreen, move the
mouse cursor onto the top or bottom menu bar while still holding the
button down—it continues scrolling and selecting in that direction.)

Double-Click—place the cursor on the word to be selected.

Double-Click the Left mouse button to select the        Word     .

Keyboard Selection—place the cursor on the word/sentence/element to be
selected.  Press the ß key and hold it down.  Press other movement
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keys, such as an arrow or page down key, to highlight the text.  Release
both keys when the desired text is selected.

Adjusting the Block Selection

If you’ve selected some text and then realized that you need to block less or
more text, you don’t have to start over.  Instead:

1. Press the ß key and hold it down.

2. Extend or reduce the selection, by using the mouse or the keyboard’s
movement keys (up, down, right, and left arrow keys).

3. Release the ß key.

De-Selecting Text

To de-select a selected block of text:

Left-Click the mouse anywhere on the page.

Or, press a movement key alone (up, down, right, and left arrow keys),
without the ß key.

Moving Text

Hollywood Screenwriter offers these methods of moving text around in your
script:

Cut and Paste—a two-step method.  Text is removed from one location and
placed on the Clipboard, then Pasted into a new location.

Copy and Paste—a two-step method.  Text is left in its original location and
placed on the Clipboard, then Pasted into a new location.

Drag and Drop—a one-step method.  Direct movement of text without
cutting or copying.
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Cutting and Pasting with the Mouse

Select the text to be moved.  Under the Edit Menu, select Cut.

Move the cursor to the place you want the text you’ve cut to appear, and click
there.  The cut text appears after the cursor position.  If you select any text in
the new position, the cut text replaces it.

Under the Edit Menu, select Paste.

Copying and Pasting with the Mouse

Select the text to be moved.  Under the Edit Menu, select Copy.

Move the cursor to the place you want the text you’ve copied to appear, and
click there.  The copied text appears after the cursor position.  If you select any
text in the new position, the copied text replaces it.

Under the Edit Menu, select Paste.

Cutting/Copying/Pasting with the Keyboard

Select the text to be edited.

Use Ç+X to cut, Ç+C to copy, and Ç+V to paste.  This is the
Hollywood Screenwriter default, equivalent to the ˚ (Command) keys in
Apple Macintosh software.

Dragging and Dropping

1. Move the cursor to the start of the text you want to move.

2. Highlight the text to move, using your preferred selection method.

3. Using the Mouse, move the cursor anywhere over the selected text and
press the Left Mouse Button down.  Hold it down.  The cursor changes
from the normal text “I-Bar” to an Arrow with a page icon at its base (the
Drag and Drop cursor.)

4. While holding the Left Mouse Button down, “drag” this block across the
page to its new position.  With the arrow cursor at the place you want
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the text inserted, release the Left Mouse Button.  The text block moves to
the new position.

Breaking Elements—Hollywood Screenwriter handles Drag and Drop text
placed in the middle of an Element in these ways:

• If the cursor is in the middle of an Element when you release the
button, Hollywood Screenwriter breaks that Element at the cursor
position.  Dropped text is inserted Between the broken Elements.

• If you release the Left Mouse Button while the cursor is at the very
beginning of the Element, text is dropped Before the Element.

• If you release the Left Mouse Button while the cursor is at the very
end of the Element, text is dropped After the Element.

Deleting Text

The following delete commands remove the selected text from your script,
without placing it on the Clipboard.  To un-delete text you’ve deleted, select
Undo before selecting any other editing command.

Delete Left of the cursor by character ...... ø

Delete Right of the cursor by character .... ƒ

Delete to End of Line.............................. Ç+Ì

Delete Current Word .............................. Ç+ƒ

Delete a Block of selected text by clicking on the Delete Block Button on the
Top SpeedBar (the icon with a large dark red X).

Un-Deleting Text

To un-delete text you’ve deleted, select Undo before selecting any other editing
command:

Under the Edit Menu, select Undo.
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Undo

To Undo a text edit, select Undo before selecting any other editing command:

Under the Edit Menu, select Undo.  Or, press Ç+ø

Hollywood Screenwriter has a multi-level undo, capable of undoing up to the
last 10 text editing changes you made.  It can undo cutting & pasting blocks,
search & replace, and more.  Hollywood Screenwriter recognizes three basic
types of editing:

• Adding text (including Pasting).

• Deleting text (including cutting/deleting blocks).

• Global processing (such as search/replace or reformatting).

If Hollywood Screenwriter can undo the changes, Undo on the Edit Menu is
selectable.  If Undo is grayed out, Hollywood Screenwriter cannot undo your
text editing.

NOTE:  For the purposes of Undo, each mouse click that you make is
considered a text edit.  The Undo function merely “un-clicks” it—which
results in no change.

Redo

To restore a text edit you’ve just Undone:

Under the Edit Menu, select Redo.

Redo can restore only one (1) text editing change.

Insert/Typeover Modes

Hollywood Screenwriter can deal with the typing of new text at the cursor
position in two different ways.  The current mode is displayed on the Bottom
Status Bar.
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Insert mode—inserts new text at the cursor position, pushing existing text to
the right.  This is Hollywood Screenwriter’s default mode.

Typeover mode—new text replaces existing text, typing over it.

To Switch between Insert        and         Typeover    :

Press the È key on the keyboard.

Or, click on the Insert/Typeover button on the Bottom Status Bar.

Bolding Text

To format existing text as Bold, select the text.  Then:

Click on the Bold Button (labeled with a B) on the Top SpeedBar.

Or, press Ç+B, or § on the keyboard.

Underlining Text

To format existing text as Underline, Select the text.  Then:

Click on the Underline Button (labeled with a      U     ) on the Top SpeedBar.

Or, press Ç+U, or • on the keyboard.

Italicizing Text

To format existing text as Italic, Select the text.  Then:

Click on the Italics Button (labeled with an I  on the Top SpeedBar.)
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Or, press Ç+Y, or ª on the keyboard.

Striking Out Text

To format existing text as Strikeout, Select the text.  Then:

Press ⁄ on the keyboard.

Removing Text Formatting

Select the text to remove formatting from.

Click on the Normal Button(labeled with an N) on the Top SpeedBar.

Or, press Ç+N on the keyboard.

Applying Multiple Text Formats

You can apply multiple formats to existing text (e.g., make text both Bold and
Italicized) without re-selecting it multiple times:

Hold down the ß key while applying any of the text formats above.  The
text remains highlighted, ready for you to apply the next format.

SpellCheck

Hollywood Screenwriter’s built-in SpellCheck system allows you to check the
spelling of your script by:

• Word

• Element

• Page

• Forwards from the cursor position

• Entire Script
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SpellCheck can also:

• SpellCheck in Foreign Languages

• Create User Dictionaries for each script

Start SpellCheck—As SpellCheck begins checking relative to the cursor
position, it’s not necessary to select the text to check.

1. Position the cursor in the word or Element you’d like to check, or
directly before the word to start spellchecking at.

2. Under the Spell Menu, select the checking method to use:

Word—spellchecks the Word that the cursor is currently in.

Element—spellchecks the Element that the cursor is currently in.

Page—spellchecks the current Page.

Forwards—spellchecks from the cursor position to the end of the
script.

Entire Script—spellchecks all text in the script.

When SpellCheck finds no misspelled words, it displays a dialog box telling you
how many words it checked.  Click on OK to exit.

When SpellCheck finds a word it doesn’t recognize, it points to it onscreen with a
large Red Arrow.  It also displays the Found Unknown Word... dialog box.
This shows the unknown word in the Word: window and offers a list of
suggested alternatives in the Suggestion: window.  Option Buttons down the
right side are:

Replace—if you find the correct spelling in the Suggestion window, click on
it and it appears in the Word window, replacing the unknown spelling.
Click the Replace button to replace it in your script also.

Auto-Correct—adds the unknown word and its correct spelling to the User
Dictionary as a Typo which should be Auto-Corrected as you type.

Learn—remember this spelling for future use by adding the word to the
current User Dictionary (USER_US.LXA, unless you specify otherwise).  All
scripts that use that User Dictionary will recognize the word.

Skip Once—skip over this appearance of the word, but stop at the next one.
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Ignore—skip over this word and all future occurrences.  Ignores the word in
all scripts you check until you Exit Hollywood Screenwriter, or Clear the
Ignore List.

Suggest—if none of the suggested spellings for your unknown word are
correct, type a different spelling in the Word box and Click the Suggest
button to have it checked.

User Dictionaries

The User Dictionary Editor allows you to add, remove, or change words in any
of your User Dictionaries.  It can be selected under Hollywood Screenwriter’s
Spell Menu as Edit       U      ser Dictionary, or run as a stand-alone program by
clicking on it in the Hollywood Screenwriter program window.

The SpellCheck Language Selection screen appears, asking you to select the
language of the dictionary you’re going to edit.  American English is selected
as the default.  Select a language and click on OK.

Next, you’re asked to Select User Dictionary.  User Dictionary files end with
the extension .lxa.  User_us.lxa is selected as the default.  Select a dictionary
and click on OK.

The User Dictionary Editor screen displays.  If opening a User Dictionary for
the first time, the file is empty and ready for you to add words.  Tab to the
Word Editing window on the right of the screen.  Buttons below it show your
options:

Add Word—type in the word the way you want it spelled (Note:  if you enter
an incorrect spelling here, SpellCheck uses it.  In effect, you’re telling
SpellCheck that this is the correct spelling.)  Click on Add Word and the word
you entered appears in the Dictionary window on the left.

To allow Hollywood Screenwriter to Auto-Correct a word as you’re typing in a
script, enter both incorrect and correct spellings here, separated by a colon.  For
example, to Auto-Correct “Dramatica” when it’s spelled as “Darmatica”, type
in “Darmatica:Dramatica”.  It’s not necessary to type a space either before or
after the colon.

The User Dictionary Editor does not distinguish between UPPERCASE and
lowercase, adding all words as lowercase.

Delete Word—in the Dictionary window on the left, highlight the word you
want to Delete.  Click on the Delete Word button.  You are prompted to
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confirm the deletion.  Click on      Y     es to delete,       N      o to keep the word in the User
Dictionary.

Edit Word—in the Dictionary window on the left, highlight the word you want
to Edit.  Click on the Edit Word button.  Your word is moved from the
Dictionary window to the Word Editing window.  Make the desired changes,
then click on either the Edit Word or Add Word button to save them back to
the Dictionary window.

Exit—quits and saves the changes you made to the User Dictionaries.  Returns
you to either Hollywood Screenwriter or the Hollywood Screenwriter program
window, depending where you launched it from.
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Printing the Script

Before printing a script, you need to configure Hollywood Screenwriter to
work with one specific printer.  With only one printer connected, your
Windows operating system automatically selects it as the default.

Printer Setup

Hollywood Screenwriter uses Windows’ Print Setup screen to let you choose
default settings for all your printing in Hollywood Screenwriter.

Under the File Menu, select Printer Setup.

The Print Setup screen displays, with the name of your currently selected
printer in the Name: window.

To select another printer, scroll through the list of connected printers in the
Name: window and click on your choice.
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Select a Paper Size.  US Letter is the standard 8-1/2 by 11 paper used for
screenplays.

Select a Paper Source .  AutoSelect Tray looks for paper in all your
printer’s sources if the Cassette runs out.  Select Manual Feed if your
printer doesn’t have an automatic feed paper Cassette.

Select a Paper Orientation.  Portrait is the standard orientation for printing
8-1/2 by 11 screenplay pages.

Click on the Properties button to select default Paper, Graphics, and
PostScript options.

Click on OK to save your default settings, Cancel to exit and discard
changes.

Print the Script

Printing in Hollywood Screenwriter is accessed through the Print dialog box.

Under the File Menu, select Print.  Or, press Ç+P.

You’ll see the following dialog box.  Check one of the print selection
radio buttons on the top half of the screen.  Hollywood Screenwriter’s
default is to select Current Page.

Current Page—If checked, prints the page that the cursor is currently on.

Current Page through to End of Script—If checked, prints from the current
page through to the end of the script.

Entire Script—If checked, prints the entire script.
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Blocked Text Only—If checked, prints the text block you’ve selected in your
script.  If no text is selected, this option is grayed out and unselectable.

Selected Pages—If checked, prints the Pages you select.  Enter the page
numbers in the same order they appear in the script (i.e. lower numbers first).

Enter individual page numbers separated by commas (1,3,32)

Enter a section of consecutive pages using a dash between the first and last
page (45-78) or (89-end)

Or combine the two methods (1,3,32,45-78,89-end)

Print Selection should Print in...—in this window, pull down and click on one
of these printing order options to select:

• Normal Order (Forwards)- prints your selection in normal
sequential order, starting with lower numbered pages/scenes.  This
is the default option.

• Reverse order (Backwards) - prints your selection in reverse order,
starting with the highest numbered pages/scenes.  Use for printers
that output the pages face up (like the HP DeskJet and Canon
BubbleJet).

Number of Copies—Enter the number of copies of your print selection to
print.  Acceptable values are between 1 and 99.

Print Title Page—If checked, prints the title page at the head of the script.
Only available if you’ve created a Title Page in the Title Page Publisher.

Fax—Click this button to Fax your print selection instead of printing it.  Only
available if you have a Fax Modem installed, with appropriate Windows
Faxing software.  Otherwise the button is grayed out and unselectable.

Setup Options

At the top left corner of the Print dialog box is the Setup pull-down menu.
Click on the word Setup to access these options:

Printer—displays the Windows Print Setup window, where you can select
a printer and change printing options (same as Printer Setup under the File
Menu).

Fax Modem—displays a Fax Modem Setup window, where you can select
from among installed Fax software print drivers.  Checking the Fax Via
Internal Spooler box ensures the most efficient faxing.
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Appendix
A—Importing

Scripts

Hollywood Screenwriter can Directly open script files saved in these formats:

• ASCII (Text)

• RTF (Rich Text Format)

• MS Word 5.5 for DOS

• MS Word 2.0, 6.0 and 7.0 for Windows

• WordPerfect 5.1 & 6.x files (for DOS and Windows)

• WordStar for DOS

Hollywood Screenwriter also supports Cut & Paste importing directly from
other Windows programs.

Preparing a Script for Importing

No matter which format you import your script into Hollywood Screenwriter
from, there are two simple rules which must be followed:

• In the original file, each script element (i.e. Character Name, Dialogue,
Action, etc.) must start on its own line.

• The script must be in a general script format (i.e. Character Names before
Dialogue and so on).



SCREENWRITER IMPORTING SCRIPTS

53.

NOTE:  The following instructions assume that your Hollywood
Screenwriter script subdirectory is set to C:\Hollywood
Screenwriter\Scripts.  If not, type in the correct subdirectory where
appropriate.

Direct Import

To open an MS Word, WordPerfect, WordStar for DOS, ASCII, or RTF file:

1. Open the Hollywood Screenwriter program.

2. Under the File Menu, select Open .

3. Select the File Type for the type of file you’re opening.   

If the file you want to import doesn’t have the appropriate File
Extension (e.g. “.RTF” for Rich Text Format,  etc.), selecting All Files
as the file type shows files with any extension.

4. Select the file you want to import to Hollywood Screenwriter.  (If
necessary, change the subdirectory by double clicking on the Path
Tree.)  Click on OK.  The Text Interpretation dialog box appears:

To import a script file, Import in Script Format should be checked.
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To import an outline or some other non-script text, check Import Text as Action
Only.

Text Only (Non-RTF) —checking this CheckBox (if available) imports the
file slightly faster, and may improve the accuracy of the import.  It also
loses any bold, italic, or underline formatting.

If you’re importing a file with Embedded Style Sheets in Rich Text Format,
such as a Final Draft script, a Use Style Sheets checkbox displays on the
menu.  Check it for better interpretation of paragraph elements.  If
Hollywood Screenwriter has difficulty interpreting any style sheet, it
prompts you to identify it.

Use most aggressive interpretation of the source text —causes Hollywood
Screenwriter to normalize inconsistent line spacing and margins.  In most
cases this produces the most accurate import.  However, it may cause
Shots to be misinterpreted as Character Names, and vice versa.

Don’t use Capitalization Information for Element identification —some
word processors lose Capitalization Information when exporting files.
Checking this box tells Hollywood Screenwriter to ignore Capitalization
when identifying Elements.

Ignore Margins for Element identification—some script files have their
script elements defined by their margins, others by codes or Hard Returns.
If a script file is being imported incorrectly due to its margins not being
what Hollywood Screenwriter expects, checking this feature may allow a
more accurate import.

Action is in Parentheticals “(“ + ”)”—check this if your import file has the
Action Element in parentheses (such as certain TV or Stage Play scripts).

5. Click on OK to import the file.

6. Under Hollywood Screenwriter’s File Menu, Save your imported file
under a new name.

If your script doesn’t import successfully, try again with different options
checked.  You may have to experiment with these options to get the best
results.
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Cut and Paste Import

Use this method if none of the other methods imports your script successfully.
To import a Script from another Windows program on the same computer as
Hollywood Screenwriter:

1. Open the other Windows program, and open the file you want to
import to Hollywood Screenwriter.

2. Under that program’s Edit Menu, Select All (or select all the text in
the file using another method).

3. Under the Edit Menu, select Copy.  Once the Copy command is
complete, the text will be on the Clipboard.  Don’t cut or copy
anything else.

4. Open Hollywood Screenwriter.

5. Under Hollywood Screenwriter’s File Menu , open a New file.
Under the Edit Menu, select Paste.  Instead of pasting the import
text in your new empty document, Hollywood Screenwriter presents
the following Text Interpretation dialog box:

To import a script file, Import in Script Format should be checked.

To import an outline or some other non-script text, check Import Text as
Action Only.
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Text Only (Non-RTF) —checking this CheckBox (if available) imports the
file slightly faster, and may improve the accuracy of the import.  It also
loses any bold, italic, or underline formatting.

Use most aggressive interpretation of the source text —causes Hollywood
Screenwriter to normalize inconsistent line spacing and margins.  In most
cases this produces the most accurate import.  However, it may cause
Shots to be misinterpreted as Character Names.

Don’t use Capitalization Information for Element identification —some
word processors lose Capitalization Information when exporting files.
Checking this box tells Hollywood Screenwriter to ignore Capitalization
when identifying Elements.

Ignore Margins for Element identification—some script files have their
script elements defined by their margins, others by codes or Hard Returns.
If a script file is being imported incorrectly due to its margins not being
what Hollywood Screenwriter expects, checking this feature may allow a
more accurate import.

Action is in Parentheticals “(“ + ”)”—check this if your import file has the
Action Element in parentheses (such as certain TV or Stage Play scripts).

6. Click on OK to paste the imported text.

7. Under Hollywood Screenwriter’s File Menu, Save your imported file
under a new name.

If your script doesn’t import successfully, try again with different options
checked.  You may have to experiment with these options to get the best
results.

Importing a WordPerfect 5.0 (for DOS) or earlier script

To import a script written in WordPerfect 5.0 or earlier for DOS:

1. Open WordPerfect and open the script you want to import to
Hollywood Screenwriter.

2. Save the file in Generic format.  Press Ç+∞ and choose Save As,
then Generic.  Type in a path and file name:  C:\Hollywood
Screenwriter\Scripts\<SCRIPT NAME>.DOS and press Â
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3. When the file is saved, press ¶.  Press N when it asks you if you
want to save, then Y to exit.

Now follow the Direct Import instructions above.

Importing a Windows Word Processor script

If the Cut and Paste method doesn’t import satisfactorily, try this method.
Also, if the Windows Word Processor script you want to import is on a
different computer than Hollywood Screenwriter, you can’t use the Cut and
Paste method.  Instead:

1. Open the Windows Word Processor, and open the script file you
want to import to Hollywood Screenwriter.

2. Under the File Menu, choose Save As.  Save the script under a
different name:  C:\Hollywood
Screenwriter\Scripts\<ScriptName>
(Save to a floppy disk if importing from a different computer.)

3. On the Save As Menu there should be an option to save the script in
a different format.  Typically, it says something like Format or File
Type or Save Type.  Change it to Rich Text Format or RTF.  If that’s
not available, choose DOS Text or ASCII Text (If DOS or ASCII
options like With Line Breaks or With Formatting are available,
select them.)

4. Click on OK to save.  When the file’s saved, exit the Windows Word
Processor.  (If importing from a different computer, eject the floppy
disk you saved to and insert it into your Hollywood Screenwriter
computer.)

Now follow the Direct Import instructions above.  (If importing from the
floppy disk, tell Hollywood Screenwriter the path and file name.)

Importing a non-Windows Word Processor script

To import a script from a non-Windows Word Processor, check that program’s
manual for Exporting instructions.  If that doesn’t help, call the Word
Processing program’s Technical Support number and ask how to produce
either:
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• a Rich Text Format (RTF)file (preferred), or

• an ASCII file, with formatting and line-feeds (or Hard Returns) at the end
of each line (If there’s no option to save directly as Text Only or ASCII,
there’s usually an option to “Print to a File”.)

Then follow the Direct Import instructions above.

Cleaning up Imported Scripts

Hollywood Screenwriter may require you to do some cleaning up after
importing a script.

To correct a mis-recognized Element, place the cursor anywhere in the element.
Click on the Current Element Window in the center of the Top SpeedBar, and
select the desired Element.

If the imported script was in TV format, you may have to reset the script’s
formats (See Choosing a Script Format for more details.)  You’ll also need to
put back in the forced Page Breaks between scenes, and re-enter the Act and
Scene Information.  Unfortunately, due to a lack of standardization in TV
formats, the import function is unable to recognize all possible permutations.

NOTE:  Although the Import function is highly accurate, we recommend
you check all imported scripts for errors before printing multiple copies.
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Appendix
B—Exporting

Scripts

Exporting to other scriptwriting or word processing programs is a matter of
saving a script in a different format.

A script exported from Hollywood Screenwriter is designed to be an editable
copy, not an exact duplicate.  It will not have exactly the same margins, page
breaks, or even number of pages as it does in Hollywood Screenwriter.
Neither will it have MOREs or CONTINUEDs.  However, it will retain all of
the text in your script and will be in general script format.

Export

To export, open Hollywood Screenwriter and open the script you want to
export.

1. Under the File Menu, select Save As...

2. At the Save File Menu, select Save as type to choose an Export
Format.
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File Type

There are the export file types (formats) currently available:

Hollywood Screenwriter—normally used for saving Hollywood
Screenwriter scripts.

Formatted ASCII —used to export to programs which cannot handle any
of the other format.  A plain text format with all the text of the script
indented correctly using spaces.

Rich Text Format—used to export to RTF format.  Compatible with most
other screenwriting and Word Processing programs.

3. Enter a new File Name for the exported file.  Hollywood
Screenwriter automatically adds the correct export file extension,
according to your chosen export format.

4. Click on OK to save the export file.

Importing a Hollywood Screenwriter Export script

To import a Hollywood Screenwriter export file into another program, check
that program’s manual for Importing instructions.  If that doesn’t help, call that
program’s Technical Support number and ask how best to do it.

The script must have been exported from Hollywood Screenwriter in a format
readable by the other program.
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Write Brothers is only able to provide technical support on the export side of
this procedure.  Unfortunately, we have no control over how another
company’s programs deal with importing.

Cut and Paste Exporting

You can export from Hollywood Screenwriter to another Windows program
on the same computer using Cut and Paste:

1. Open the Windows program you want to export to.  Open a file to export
to, or open a new file.

2. Open Hollywood Screenwriter and open the script you want to export
from.

3. Using the mouse, select the text to export.

To select the entire script, under the Edit menu, Select All.

4. Under the Edit menu, select Copy.

5. Go to the other Windows program.

6. Under the Edit menu, select Paste.

All of Hollywood Screenwriter’s formatting may not transfer, but you should
at least be able to export all the text.  Be warned that not all Windows
programs can handle Cut and Paste correctly.
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C—Main!Menu!B

ar

Hollywood Screenwriter’s Main Menu Bar gives you access to eight main pull-
down Menus.  Most of their features have been covered elsewhere in this
manual, and are included here for easy reference.

F     ile Menu

N      ew—opens a new blank script.

O      pen—by default, displays a list of existing Hollywood Screenwriter scripts to
be opened.  Also allows you to open files in other formats, for purposes of
importing.

C     lose—exits the currently displayed script, prompting you to save it.

S     ave—saves the currently displayed script without prompting you for a file name.
Automatically overwrites any previously saved version of a script with the
same name.

Save       A      s...—saves the currently displayed script to a different name, location,
or format.

B     ackup to Floppy—saves a copy of the currently displayed script to floppy
drive A:, or B: if available.

Title Page P     u     blisher—displays the Title Page Publisher for WYSIWYG
Drag’n’Drop creation of Title Pages.
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P     rint—displays a dialog box where you can select what to print or fax.

Prin   t   er Setup—displays a dialog box where you can select a printer and
change printing options.

Setup Menu Fonts—displays a dialog box where you can change the way text
is displayed on Hollywood Screenwriter’s menus and dialog boxes.  This is the
same dialog box seen during installation.

E    x    it—exits Hollywood Screenwriter, prompting to you save any open scripts.

1    ...    3    <FileName>—the File History List, with names of recently saved scripts.
Select one to re-open it.

E     dit Menu

U      ndo—Takes a step back, undoing the last text edit performed.  This option is
grayed-out (unselectable) if Hollywood Screenwriter cannot Undo the changes.

R    e    do—Restores what you just undid.  Only available immediately after you’ve
performed an Undo, prior to making any more changes.

Cu   t   —removes selected text from the script, placing it on the clipboard.

C     opy—copies selected text, leaving it in the script but also placing it on the
clipboard.

D      elete—deletes selected text, removing it from the script but not putting it into
the clipboard.

P     aste—places the contents of the clipboard into the script at the cursor
position.

Select       A      ll—selects the entire contents of the currently displayed script.

Turn Off Bloc     k     —un-selects the currently selected text.

Add Forced Page      B     reak—starts a new page at the current cursor position.

R     emove Forced Page—removes a Forced Page Break immediately before or
after the cursor position.

Add       H      ard Return—goes to a new line, but stays in the same element.
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Normal        W       P Mode—toggles between the script format you’re using and Word
Processing mode, where Tab and Enter function as in other Windows word
processing programs.

Load For      m      at Menu

S     creenplay—loads this script format, and applies it to the currently selected
script if one is open.  This is Hollywood Screenwriter's default choice.

T     V Formats—loads a television script format, and applies it to the currently
selected script if one is open.  Choose from over 50 sitcoms, episodic dramas,
and soaps.

Stage      P     lay—loads this script format, and applies it to the currently selected
script if one is open.  Conforms to Samuel French's published play format.

S     earch Menu

S     earch—displays the Search & Replace dialog box, with the Replace
parameters grayed out.  Enter the text to Search for, and define the search
parameters.

Search &      R     eplace—displays the Search & Replace dialog box.  Enter the text to
Search for, the text to Replace it with, and define the Search & Replace
parameters.

Search       A      gain or Search & Replace Again—repeats or continues the previous
Search/Replace command, starting from the current cursor position.

C     hange Character Name—displays a Search & Replace dialog box, modified
for Character Names only.  The Search for: box contains a list of available
Character Names to choose from.  Choose one, enter the new Name in the
Replace with: box, and define the Search & Replace parameters.

G     oto Menu

T     op—takes you to the Top of the script.

B     ottom—takes you to the End of the script.

P     age—takes you to a specific Page Number or Scene Number.
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S     cene—displays a Scene Heading list, allowing you to select the one to go to.

Act   /   Scene Info—in a Television or Stage Play format script, displays an
Act#/Scene# list, allowing you to select an Act to go to.  Takes you to that
Act’s first Scene Heading.

S     p     ell Menu

W       ord—spellchecks the Word that the cursor is currently in.

E     lement—spellchecks the Element that the cursor is currently in.

P     age—spellchecks the current Page.

F     orwards—spellchecks from the cursor position to the end of the script.

Entire      S     cript—spellchecks all text in the script.

C     ount Words—counts the number of words in the script.

Clear     I    gnore List—clears from memory all the words that you’ve told
SpellCheck to Ignore this writing session.

Edit       U      ser Dictionary—takes you to Select Language, then to a dialog box to
choose a User Dictionary to edit.  Add, delete or edit words to be used by
SpellCheck or Auto-Correct.

W      indow Menu

C     ascade—cascades (shrinks and overlays at an offset) all open script windows.

T     ile—tiles (shrinks and stacks horizontally) all open script windows.

A      rrange Icons—neatly arranges the icons of any minimized script windows.

M       inimize All—minimizes (shrinks to icons at the bottom of the window) all
open script windows.

Ma    x    imize Window—maximizes the currently selected script window.  Click
on a script icon to select it.

Redra      w       Screen—forces the screen to be redrawn.
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1    ...    9     <FileName>—lists the Names of all open script windows, with a
checkmark by the currently displayed script.  Select one to make it the active
open window.

H     elp Menu

C     ontents—displays the main contents window of the Online Help.

Quick Help––displays a Sample Script Page.  Move the cursor over an item to
get a Hint, and click on any item to get a brief Help screen.

Search     f    or Help On...—displays the searchable Index of the Online Help.

Script Anal     y     sis—provides statistical information (printable) about your scenes
and characters.  This report can also be printed, or saved to a PrintScript file.

A      bout...—displays Hollywood Screenwriter Version information, and
Registration information (if you entered it at Installation).
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D—Command

Keys

Special Keys

These are the only special keys you need to use to write with Hollywood
Screenwriter:

† Tab takes you to the Character Name element from any
other element.

Â Enter takes you to any other element except Character Name
(for example, pressing Â while in Character Name
takes you to Dialogue; while in Transition, it takes you to
Scene Heading, etc.)

( Left parenthesis takes you to Parenthetical if pressed while
in Dialogue, or Character Extension if pressed while in
Character Name.

Formatting is done for you by Hollywood Screenwriter as you write (e.g. type
int. at the beginning of any blank line and Hollywood Screenwriter
automatically formats that as a Scene Heading.)

Cursor Movement Keys

Use the following keys to move the cursor around the script quickly:
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Å+˜ ................................... Previous Element

Å+¿ ................................... Next Element

Ç+Å+˜ ........................... Previous Scene

Ç+Å+¿ ........................... Next Scene

Ç+Å+Ó .......................... Goto Top of Script

Ç+Å+Ì .......................... Goto End of Script

Ç+G .................................. Goto Page Menu

˘ .......................................... Next character

¯ .......................................... Previous character

Ç+˘ .................................. Next Word

Ç+¯ .................................. Previous Word

Ó ......................................... Beginning of current line

Ì ......................................... End of current line

˜ .......................................... Previous Line

¿ .......................................... Next Line

“ ......................................... Previous Screen

” ......................................... Next Screen

Control-Keys

The following keys are optional Quick Keys to use for text input.  Most of them
also have a Menu or Speed Button equivalent:

Ç+B .... Toggles Bold on/off.

Ç+C .... Copies highlighted text.
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ß+Ç+C Displays a pop-up list of all Existing Character Names
for your selection.

Ç+E .... Puts you into a Scene Heading element and inserts EXT.

Ç+G .... Pops up the Goto Page Menu.

Ç+I .... Puts you into a Scene Heading element and inserts INT.

Ç+L .... SpellChecks the word preceding the cursor.

Ç+O .... If you aren’t in a Shot element, it puts you into one.
If QuickType is on, a pop-up list of Initial Shot Text displays
for your selection.
If you’re already in a Shot, then the list of Initial Shot Text
displays regardless of the status of QuickType.

Ç+P .... Pops up the Print dialog box.

Ç+R .... Forces a Repagination of your script.

Ç+T ............. If you aren’t in a Transition element, then it puts you
into one.

Ç+U ............. Toggles Underlining on/off.

Ç+V ............. Pastes text from the clipboard.

Ç+W ............. Toggles Word Processor mode on/off.

Ç+X ............. Cuts highlighted text.

Ç+Y ............. Toggles Italics on/off.

Ç+Â........ Puts you into an Action element.

ß+Â ...... Inserts a Forced Page Break.

Function Keys

Function Keys give you another way to access features also available through
Pull-Down Menus or other keystrokes.
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¡ ..................... Pops up the Help Menu.

t ..................... Pops up the Search for Text box.

Å+t .............. Pops up the Search/Replace Text box.

Å+¢ .............. Exits Hollywood Screenwriter.

Ç+¢ ............. Closes the currently active open script.

§ ..................... Toggles Bold on/off.

Ç+§ ............. Switches between a number of open Scripts.

¶ ..................... Saves the script without prompting for a file name.

• ..................... Toggles Underline on/off.

ª ..................... Toggles Italics on/off.

º ..................... Pops up the Save As dialog box.

⁄ ..................... Toggles Strikeout on/off.
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User Dictionary Editor (DICTEDIT.EXE)

The User Dictionary Editor allows you to add, remove, or change words in any
of your User Dictionaries.  It can be selected under Hollywood Screenwriter’s
Spell Menu as Edit       U      ser Dictionary, or run as a stand-alone program by
clicking on it in the Hollywood Screenwriter program group window.

The SpellCheck Language Selection dialog box appears, asking you to select
the language of the dictionary you’re going to edit.  American English is
selected as the default.  Editing of other languages requires installation of
optional Foreign Language Dictionaries.  Select a language and click on OK.

Next, you’re asked to Select User Dictionary.
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User Dictionary files end with the extension .lxa.  User_us.lxa is selected as the
default.  Select a dictionary and click on OK.

The User Dictionary Editor screen displays:

If opening a User Dictionary for the first time, the file is empty and ready for
you to add words.  Tab to the Word Editing window on the right of the screen.
Buttons below it show your options:

Add Word     —type in the word the way you want it spelled (Note:  if you enter
an incorrect spelling here, SpellCheck uses it.  In effect, you’re telling
SpellCheck that this is the correct spelling.)  Click on Add Word and the word
you entered appears in the Dictionary window on the left.

To allow Hollywood Screenwriter to Auto-Correct a word as you’re typing in a
script, enter both incorrect and correct spellings here, separated by a colon.  For
example, to Auto-Correct “Dramatica” when it’s spelled as “Darmatica”, type
in “Darmatica:Dramatica”.  It’s not necessary to type a space either before or
after the colon.

The User Dictionary Editor does not distinguish between UPPERCASE and
lowercase, adding all words as lowercase.

Delete Word     —in the Dictionary window on the left, highlight the word you
want to Delete.  Click on the Delete Word button.  You are prompted to
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confirm the deletion.  Click on      Y     es to delete,       N      o to keep the word in the User
Dictionary.

Edit Word     —in the Dictionary window on the left, highlight the word you want
to Edit.  Click on the Edit Word button.  Your word is moved from the
Dictionary window to the Word Editing window.  Make the desired changes,
then click on either the Edit Word or Add Word button to save them back to
the Dictionary window.

Exit    —quits and saves the changes you made to the User Dictionaries.  Returns
you to either Hollywood Screenwriter or the Hollywood Screenwriter program
window, depending where you launched it from.
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Forwards 48
Found Unknown Word...

45
Function Keys 71

G

Goto Bottom 65
Goto Menu 65
Goto Page 65, 71
Goto Scene 65
Goto Top 65
Grid 21

H
Hard Return 35
Help 71
Help Menu 10, 66
Hollywood’s Screenplay

Format 1
HP DeskJet 49

I
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